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Summer Hours start at 6:00 P.M. (April through September) 
 
Winter Hours  start at 3:00 P.M. (October through March) 
 
Location:  Christ Lutheran Church 

481 Snead Drive, Fairfield Glade TN 

  

Tuesday, May 12, 2020 
 
Plateau PC Users Group will be  
suspending on a temporary basis the  
General Meeting for  May 2020.  
 

 
 
 
 
 
 
 
 
 

Further monthly meeting will also be 
suspended on a temporary basis,  
until it becomes safe to restore our 
Tuesday meetings.  
 
Stay well and safe. 
 

Memorial Day Monday, May 25, 2020 
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Join the Club! 
Anyone interested to attend the general meeting or any of the 
SIG meetings as a guest will be charged $3.00 per person for 
any or all meetings in that month. Afterwards, you are en-
couraged to become a member of the Plateau PC Users 
Group.  
Our Club cannot exist without you, the members.  
  
Membership Dues  

Our annual dues are now payable July 1st of each year.   
Annual dues are $24 per single person / $30 per family  
starting July 1, 2014.with partial years dues as follows: 

  
 
 

 
 
 
 
 
 
 

Student memberships (21 and under) are $10 annually.   
Corporate memberships are $30 a year for the first two  
memberships and $10  a year for each additional  
membership from the same company.   
Contact the PPCUG Treasurer (931) 707-3677  
for pro-rated dues of these types of memberships. 
 

BOARD OF DIRECTORS DISCLAIMER 
 

All members of the Plateau PC Users Group are willing to 
help one another in the area of advice and tutorial instruc-
tion over the phone.  If you should require more involved 
services or instruction, we have a few members who are 
very knowledgeable in several areas.  As a responsible  
consumer, it is up to you to discuss, before retaining a mem-
ber, any and ALL charges for repair services and time con-
suming tutorial activities. 
 
It is not the desire of this Board of Directors to set fees for 
individuals for services rendered, nor the responsibility to 
intervene between members who enter into a contract 
among themselves. 
 
The GAZETTE is published using the following:  Microsoft 
Word, Microsoft Publisher, and Microsoft Windows.  The 
Gazette is the monthly newsletter of the Plateau PC Users 
Group, Inc. 
 
DISCLAIMER:  No warranty, express or implied, is made 
by the PPCUG, the Gazette editorial staff or its contributing 
editors.  This extends to all losses incidental or consequen-
tial from the use or non-use of any information in any issue 
of the Gazette. 
 
All images used in the newsletter, website, blogs, class mate-
rials or handouts (“media”)  are obtained from a “free use” 
source, preferably images that have been released as “CCO 
Public Domain”. 

 
2019-2020 PPCUG, Inc. Board Members 

President Steve Rosenstein (931) 742-0151 

Vice-President/  
Compliance  

Jim Buxton (931) 456-6009  

Treasurer John Krueger (931) 707-3677 

Acting Secretary Richard Del Frate (931) 456-2251 

Past President Carl Nordeen  (931) 456-5597 

Membership John Krueger (931) 707-3677 

Publicity Mary Anne Nordeen  (931) 456-5597 

Gazette Editor Gordon Botting (931) 456-2184 

APCUG Rep  Steve Rosenstein (931) 742-0151 

Equipment  
Custodian 

 Bob Willis (931) 456-6511 

Webmaster Alan Baker  (931) 239-0877 

   

Directors at Large 

Gordon Botting Richard Del Frate Barbara Duncan 

Charlie Merrick Bob Willis  

   

 
Join In 

Jul-Sep  
Annual 

Dues 

Oct-Dec  Jan-Mar Apr-Jun 

Single: $24 $18 $12 $6 

Families: 
$30 $22 $15 $7 

Printed by, Business Equipment Clinic 
539 West Ave. Suite 101  Crossville TN 38557 
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Up Coming Meeting for June 2020  
Note: Summer Hours 6:00 P.M. 

 
The next General Meeting of the 
PLATEAU PC USERS GROUP 

Maybe Suspended 

** Visit the PPCUG Website ** 

At: www.PPCUGinc.com. 
 
Read all about our club activities and scheduled monthly meetings, also current and past 
issues of the  Gazette Newsletter. Links also to the Meeting Handouts on past presenta-
tions. 
 

Send your comments and suggestions to the PPCUG Webmaster, Alan Baker 
jackal33980@gmail.com  (931) 239-0877 

Cool Tips & Sites 
 

To insert a watermark in Microsoft Word: 

Create a Watermark 

1. In Microsoft Word, select the Design tab. 

2. Choose Watermark (in the Page Background group). 

3. Select from a group of common options including CONFIDENTIAL, DRAFT, URGENT or 
pick Custom Watermark to add a graphic or your own customized text watermark. Word also in-
cludes the option to download additional watermarks from the Microsoft Office website. 

4. Next pick a picture or text watermark and then build your custom watermark from the choices in the 
dialog box. Your options include formatting text, font, color, and even the direction of the text 
(diagonal or horizontal). 

5. Experiment with the Washout (picture watermark) or Semitransparent (text watermark) options which 
lighten the watermark to make the text on top easier to read. 

6. For text watermarks, a bold or thick sans-serif font (no flourishes or font “tails”) such as Arial Bold, 
Calibri or Verdana is often more readable than a serif font like Times New Roman or Cambria. 

7. Pick Apply to preview your watermark. Choose OK to add the watermark to your document. 
 

To remove a watermark in a document in Microsoft Word: 

Remove a Watermark 

1. Select the Design tab. 

2. Choose Watermark (in the Page Background group). 
3. Select Remove Watermark. 
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Adding a Page Border in Microsoft Word 

Creating a page border in Microsoft Word will depend on your version of Microsoft Office. For Office 365 
and Office 2019, open a Word document and click the “Design” tab in the ribbon. 

If you have an older version of Office, click the “Layout” or “Page Layout” tab instead. 

From here, click the “Page Borders” button, in the “Page Background” section of the ribbon. 

 

By default, the “Borders and Shading” box that opens should default to the “Page Border” tab. If it doesn’t, 
click on that tab to enter your border settings. 

Click “Box” to add a typical box border to your document. You can use the default style, color, and border 
width, or change these settings from the various drop-down menus. 

Click “OK” to apply the page border to your Word document. 

 

By default, this border style is ten applied to every page. 

Your document editing view will update to show the new border applied. 

 

Alternative Page Border Styles and Formatting 

The box page format is the default style, but alternative border styles and formatting options are available for 
you to use instead. 

The box border is the most basic, adding a solid line with no shadow to your page. Even that can be custom-
ized with different types of lines, widths, and colors. 

(Continued on page 5) 
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Custom Page Border Settings and Styles 

Other than the box border, you can also apply a border with a shadow, a “3D” style border, and a custom 
border with mix-and-match options for each side. 

To do that, select one of the options from the “Setting” section in the “Page Border” tab of the “Borders 
and Shading” dialog box. Your chosen style will appear for you to review in the “Preview” section before 
you apply it to your document. 

 

Applying or Removing Individual Border Lines 

If you want to apply or remove individual border lines from your document (for instance, removing the 
border from the bottom of a page), you can do this from the “Preview” section. 

If a border is applied, click on the border line to remove it. To apply it again, click on the line to make it re-
appear. 

 

Applying Custom Border Lines 

Clicking on individual border lines in the “Preview” section is also how you can apply different styles to 
different lines when the “Custom” border setting is selected. 

To do this, click the “Custom” button in the “Setting” column, select a line style from the “Style” drop-
down menu, and then click on one of the border lines in the “Preview” box. 

 

(Continued from page 4) 

(Continued on page 6) 



Gazette May 2020     www.PPCUGinc.com                                                Page 6  

Changing Border Width and Color 

You can make your border stand out with different colors and border widths. A wider border width will 
make your border stand out more in your document. 

Border widths start from 1/4 pts and go up to 6 pts. A preview of your chosen border width appears in the 
“Preview” section. You can select any color you choose, either from the predefined options or by using the 
RGB color chart. 

To change the border width or color, select your chosen options from the “Color” and “Width” drop-down 
menus. If you have the “Custom” border setting applied, you’ll need to click on each border line in the 
“Preview” section to apply your chosen settings to those lines. 

 

Adding a Border to a Single Page 

Microsoft Word will usually apply border styles to each page, but you can apply a page border to an individ-
ual page or exclude certain pages like your front page. 

To do this, enter the “Page Border” settings menu (Layout/Design/Page Layout > Page Borders) and click 
the “Apply To” drop-down menu. 

If you want to apply a border to an individual page, make sure you’re active on that page in the Word docu-
ment before entering the menu. 

From the “Apply To” drop-down menu, select “This Section” to apply it to the page you’re currently on. To 
apply your border to the first page only, select “This Section – First Page Only” or, to apply it to all pages 
except the first page, select “This Section – All Except First Page” instead. 

 

Click “OK” to save when you’re ready.  

This will then apply your page border to the pages you’ve specified, rather than to the entire document. 

(Continued from page 5) 
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Chromebook Keyboard Shortcuts: The Ultimate Guide 

ByRyan Dube 

Last Updated on February 25, 2020 

Most Chromebook users are mobile and without a 
mouse. Keep this Chromebook keyboard shortcuts  

 
A Chromebook is a device that offers mobility and convenience. Everything works faster on a Chromebook. 
So it makes sense that most users love all of the Chromebook keyboard shortcuts that are available to them. 

Most of the time when you’re using a Chromebook, you’re going to be on the go. This means you won’t 
have a mouse and only access to the keyboard. So keep this Chromebook keyboard shortcuts guide book-
marked and handy so that you can have a more efficient experience. 

Common Chromebook Keyboard Shortcuts 
Let’s start off with the most common keyboard shortcuts that Chromebook users use. 

· Take a screenshot: Cntrl + Show Windows  

· Screenshot a window: Shift + Cntrl + Show Windows  

· Lock the screen: Search + L 
· Sign out: Shift + Cntrl + Q (twice) 
· Open files app: Shift + Alt + m 

· Toggle caps lock: Search  + Alt 
· See notifications: Shift + Alt + n 

· Magnify screen: Cntr l + Search  + m (Same to disable) 
· Select shelf icons: Alt + 1 through Alt + 8 

 
Probably the most useful Chromebook keyboard shortcut is the one you can use to browse all available key-
board shortcuts on your Chromebook. To see this guide, press Cntrl + Alt + /. 

 
(Continued on page 8) 
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This guide is organized into six major categories so that it’s easy to find the shortcut that you want. There’s 
also a search field at the time to do a quick search for what you need. 

Chrome Browser Shortcuts 
The Chrome browser is the default browser on your Chromebook. So, it stands to reason that there are a lot 
of Chromebook keyboard shortcuts focused on the Chrome browser. 
Don’t worry about clicking your mouse. Just use any of these keyboard shortcuts to save time.  

Managing Chromebook Windows 
There are a lot of ways to open, close, or switch between Chrome windows. 

· New Chrome window: Cntrl + n 
· New Chrome incognito window: Shift + Cntr l + n 
· Close current window: Shift + Cntrl + w 
· Switch between open windows: Alt + Tab 
· Switch to least used window: Shift + Alt + Tab 
· Dock window left: Alt + [ 
· Dock window right: Alt + ] 
· Maximize current window: Alt + = 
· Minimize current window: Alt + – 

 Switch windows between monitors: Search  + Alt + m 
 

 

Managing Chrome Tabs 
Most of the time when you’re using your Chromebook, you’ll be using the Chrome browser. Chromebook 
has a long list of great Chromebook keyboard shortcuts for managing tabs fast and efficiently. 

· Open new tab: Cntrl + t 
· Close current tab: Cntr l + w 
· Reopen last tab or window closed: Shift + Cntr l + t 
· Switch to tab 1-8: Cntrl + 1-8 
· Switch to last tab: Cntrl + 9 
· Switch to next tab: Cntrl + Tab 
· Switch to previous tab: Shift + Cntrl + Tab  
· Open a URL in a new tab: Type the URL in the address bar and press Alt + Enter  

Managing Links 
If you wanted to open a link in the background, you could always right-click and select Open link in new 
tab. But since most Chromebooks require you to hold down the alt key to right-click the mouse, that can 
get annoying. 
The following are useful Chromebook keyboard shortcuts that’ll save you a few extra annoying steps. 

(Continued from page 7) 

(Continued on page 9) 
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· Open link in a new tab in the background: Cntrl + click the link 

· Open link in a new tab: Shift + Cntrl + click the link (or drag the link to a blank area in the tab 

strip) 

· Open link in the same tab: Drag the link to the address bar  

· Open link in a new window: Shift + click the link 

Navigating Pages 

Finally, one of the fastest ways to navigate through your browsing history is by surfing forward and backward 
through it. There are a couple of Chromebook keyboard shortcuts that’ll help you with that. There is also a 
long list of great shortcuts to use when you want to quickly navigate the page you’re viewing. 

· Previous page in history: Alt + Left Arrow 

· Next page in history: Alt + Right Arrow 

· Scroll down: Space bar  

· Page Up or Down: Search  + Up/Down arrow or Alt + Up/Down arrow 

· Go to top: Cntrl + Alt + Up arrow 

· Go to bottom: Cntrl + Alt + Down arrow 

· Reload page: Cntrl + r  

· Zoom in: Cntrl + + 

· Zoom out: Cntr l + – 

· Reset zoom: Cntrl + o 

· Stop page load: Esc 

· Save page as a bookmark: Cntr l + d 

· Search the page: Cntr l + f 

· Perform Google search: Cntrl + k or Cntrl + e 

· View history: Cntr l + h 

· View downloads: Cntr l + j 

· Print page: Cntr l + p 

· Save page: Cntrl + s 

 

(Continued from page 8) 

(Continued on page 10) 
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Chromebook System Keyboard Shortcuts 

Now you know how to use Chromebook keyboard shortcuts for browsing with Chrome. It’s time to explore 
other shortcuts that can help you with the Chromebook system and files. 

· Open status bar: Shift + Alt + s 
· Next page in history: Alt + Right Arrow 
· Scroll down: Space bar  

· Use function keys: Search  + 1 (F1) through = (F12) 
· Increase/lower screen resolution: Shift + Cntrl + +/- 
· Reset screen resolution to default: Shift + Cntrl + o 
· Switch to next user: Cntr l + Alt + . 
· Switch to the previous user: Cntrl + Alt + , 
· Toggle ChromeVox (speech): Cntr l + Alt + z 

There is also a whole set of keyboard shortcuts you can use to navigate throughout the Chromebook window 
without using any mouse at all. 

 Highlight launcher button: Shift + Alt + L 
· Highlight next shelf item: Shift + Alt + L and Tab or Right Arrow 
· Highlight previous shelf item: Shift + Alt + L and Shift or Left Arrow 
· Open highlighted button: Shift + Alt + L and Space or Enter  
· Remove highlight: Shift + Alt + L and Esc 

· Switch focus between screen area: Cntrl + Back  or Cntrl + Forward  
· Highlight bookmarks bar: Shift + Alt + b 
· Highlight address bar row: Shift + Alt + t 

· Open right-click menu: Search + Shift + Volume  
 

 

(Continued from page 9) 

(Continued on page 11) 
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Text Editing Keyboard Shortcuts 

Editing a document is a common task on a Chromebook, and keyboard shortcuts can make the job a whole 
lot easier. 

· Select all: Shift + a 
· Select next word: Shift + Cntrl + Right arrow 

· Select text to end of the line: Search + Shift + Right arrow 
· Select previous word or letter: Shift + Cntrl + Left arrow 
· Move to end of next word: Cntr l + Right arrow 
· Move to start of previous word: Cntrl + Left arrow 

· Move to start of the current line: Search + Left arrow 

· Move to end of the current line: Search + Right arrow 

· Skip to end of document:  Search + Cntrl + Right arrow 

· Skip to start of document: Search + Cntrl + Left arrow 
· Copy selected text: Cntrl + c 
· Cut selected text: Cntrl + x 
· Paste text from clipboard: Cntrl + v 
· Delete previous word: Cntrl + Backspace 
· Undo last action: Cntr l + z 
· Redo last action: Shift + Cntrl + z 

 
Now you know everything you need to know in order to use any Chromebook keyboard shortcut effectively. 
So, bookmark this page and return to it any time you need to look for which keyboard shortcut you need. 

 

Staying Safe Online - A Rational Approach 
 

Pam Holland, Founder and President, Tech-Moxie 
December 2019 
https://www.tech-moxie.com/ 
Pam (at) tech-moxie.com 
 
We get many questions about online security. And we often get brought in to help clean up after an inci-
dent of fraud. As a result, we have developed what we consider 'a rational approach' to online security.  
Rather than focusing on all of the possible risks, we urge our clients to first address factors that present the 
highest risk. With respect to protecting from online risk, we apply the 80/20 rule. In short, 80% of the risk 
comes from 20% of the possible causes. In other words, if we just address the top possible risks, we elimi-
nate the most common ways people are victimized online. 
 
We suggest thinking about protecting your data as you might approach protecting your home.  We all 
take reasonable steps to secure our homes; we lock our doors, close windows, and leave lights on. The goal 

(Continued from page 10) 

(Continued on page 12) 



Gazette May 2020     www.PPCUGinc.com                                                Page 12  

is to reduce risk as eliminating risk is nearly impossible. The same is true in our digital lives. Taking small 
measures goes a long way towards keeping us safe, but it is nearly impossible to eliminate all risk. 
 
Consider your personal risk factors.  This is not unlike assessing your home for the risk of a break-in. If 
you live on the top floor of a high-rise, leaving your windows open does not present the same risk as if you 
were on the ground floor. With respect to your tech, do you have people regularly in your home that you 
need to protect your data from? Do you bank online? Do you have sensitive financial or other documents 
on your computer? Do you only use your computer for email? Do you or a family member have cognitive 
issues that might make you more vulnerable to fraud?  
 
Based on our experience seeing the aftermath of fraud, taking steps to cover these six items will go 
far towards your online safety: 

1. Use Unique Passwords. I know this isn't what many want to hear, but unfortunately, the risk in 
re-using the same password is increasing. A few years ago, the common advice was to create a 
unique password that was hard to guess. Today, the risk is not that someone will guess your pass-
word - the fraudsters already know it. Large corporate data breaches (e.g., Equifax and Marriott) 
may have put our passwords into the hands of fraudsters. If you typically use the same password 
for multiple accounts (and worse if you have used it for years), fraudsters are more likely to be 
able to access your other accounts. To return to the home analogy, it is as if you have given out 
your key to numerous people over the years - it's now time to change the locks. Some options: 

o Use a password manager - This might mean allowing Chrome or your Mac to save 
your passwords or using a third-party service like LastPass. I am often asked if they are 
safe. The only answer that I can really give is that they are safe until they aren't. I have 
chosen to allow my passwords to be saved on my Mac. For me, it has reduced my risk 
(because I don't need to reuse passwords) while (somewhat) saving my sanity. But a 
caution: If others have access to your computer, they may be able to view your pass-
words. 

o Write them down - This works well for many. Of course, it is important to keep the 
passwords in a safe place.  

o Develop a unique naming convention - For example, you might take a short phrase 
that you will remember then add something unique to that account site.  

o Make your passwords safer by using two-step authentication - This is an option in 
most online accounts (email, Facebook, banking). How does it work? When you log in 
from a new device or location, you'll be sent a code via smartphone or landline. This 
makes it harder for fraudsters to log into accounts even if they have your password. To 
set up, go to the account or privacy/security settings in your online accounts. 

2. Never Allow Remote Access to Your Computer (unless you have sought reputable assistance 

like from Tech-Moxie ). Fraudsters would like nothing more than to gain access to your com-
puter. They pretend to be from Amazon, Microsoft, Apple or another company you know well, 
offering to "help" you with a service issue. Assume fraud if you get an email, call or computer 
alert from a familiar company or government name. Once in your computer, they can access ac-
counts and passwords. We have seen quite a lot of damage from these schemes. 

(Continued from page 11) 
 

(Continued on page 13) 
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3. Think Before You Click. Assume links in the email are fraudulent unless you can prove other-
wise by checking with the sender. Fraudsters easily create emails that look like they came from a 
friend, bank or even the government. The email might be friendly ("Hey, check this out") or in-
tended to provoke anxiety ("your Amazon order for a diamond ring has just shipped") or seem-
ingly innocuous ("your computer needs service"). Fraudsters are hoping to get passwords or other 
personal information. Remember, customer service doesn't come to you! Instead of clicking, go to 
the website directly via the internet. 

4. Beware of Pop-Ups A "pop-up" is a window or box that opens on your computer - often with a 
warning. Do not believe pop-up warnings claiming there is a problem with your computer. Never 
give them remote access. Warnings may claim to be from Microsoft, Apple or another company 
you are familiar with. What to do? Shutdown and restart your computer and the pop-up should be 
gone! 

5. Update Devices Regularly. Companies like Microsoft, Apple and Google lookout for software 
vulnerabilities that fraudsters can take advantage of. They issue updates to fix these issues. Some 
devices may be set to automatically update, but others may require you to take a specific action. 
This applies to computers, tablets and smartphones. 

6. Beware the Telephone. Scams change but follow common themes. Neither Apple nor Microsoft 
will call to alert you of problems. Government agencies such as IRS, Social Security Admin nor 
the local Sheriff will call claiming you owe money. If you are still in doubt, hang up and call the 
agency from a number that you have looked up independently. 

We hope you find these tips helpful - and as always, we are here to help! 
 
 
 

Is “Refurbished” Worth the Price? 
 

News and/or Opinion from Paul Baecker, Newsletter Publisher & Editor 
Sterling Heights Computer Club 
October 2019 issue, WYSIWYG 
www.sterlingheightscomputerclub.org 
newsletter (at) sterlingheightscomputerclub.org 
 
I recently went shopping for a cable modem to eliminate the rental cost of the one supplied by my ISP.  
After doing some online research, I decided on a capable Arris model and found it at a local retailer. The 
store had some new ones but also had some refurbished ones for about half the price of the new ones.  
 
I thought to myself, well, they’ve simply been returned by shoppers who had changed their minds because 
they didn’t like the color or style, and the units were probably basically unused. I inquired and learned that 
they had previously been used in a business somewhere (how would the salesman know?). So next I 
thought, well, do I want to save a few bucks by buying this so-called refurbished unit? Surely, the items 
would have been repaired (if necessary) and tested by an OEM (Original Equipment Manufacturer) facility 
so that they operated as though they were new, even if they did have some wear marks on them. A no 
brainer to save the money, right?  

(Continued from page 12) 
 

(Continued on page 14) 
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But for whatever reason, I got a bit more inquisitive and asked about to what extent these items were re-
furbished. To the original manufacturer’s specifications? In this case, nope. Well, then, surely the store 
could vouch for the level of refurbishment done by the third party. Nope again.  
 
I learned that there are businesses that exist to refurbish electronic products to their own specifications, 
and they are not necessarily noted as to their relationship to the product’s original specs. My excitement 
in getting a great deal was gradually waning. Finally, the store rep tells me that they offer a 14-day return 
on a purchase of this item, but no warranty beyond that return option. I eventually passed on this offer. I 
figured that with my luck, the item would last past those 14 days, but die too soon thereafter.  
 
I also checked the details on the web site of a popular online retailer of computers and accessories. I 
found similar statements about refurbished products being refurbished to the specs of the refurbishing  
organization. Some refurbished items came with warranties, some could be warranted at extra cost, and 
some items were ‘as is’ (such as demos) with no right to complain after the purchase.  
 
So, what this adventure taught me is to carefully vet the retailer of any refurbished item you’re consider-
ing (whether electronics, furniture, appliances, etc.) and carefully study the purchase agreement and any 
(often hidden) disclaimers that apply to the purchase.  
 
A definition I found online for the term “refurbish” is “to brighten or freshen up,” 
 
Yikes!!!  
 
This is an online article about doing your homework when shopping for refurbished products. You can 
snag discounts as high as 50% off on smartphones, tablets, computers and associated devices when look-
ing for a refurbished unit, but you've got to do your homework. https://lifehacker.com/when-should-i-buy-
refurbished-electronics-5885492  
 

More Windows Tips and Tricks 

Use Custom Install 

When you are setting up Windows 10 on a new PC, make sure you select the Custom install option in-
stead of the default Express install. 

It is more involved but lets you modify important aspects of your installation such as the privacy settings. 

 Remove old files after installing Windows 10 

If you have no intentions of reverting to the previous version of Windows, you can save disk space by 
getting rid of the old OS files.  

Head over to Control Panel > System and Security > Administrative Tools > Disk Clean-up and toggle 
the 'Previous Windows installations' box in the list. 

 

 
 

(Continued from page 13) 
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PLATEAU PC USERS GROUP, Inc. 

APPLICATION FOR MEMBERSHIP 

  

          ____ New Member                    ____ Renewing Member 
  

  

Return this application, with check for annual dues payable to "PLATEAU PC USERS GROUP." Return to the club 
Treasurer during our meeting or mail to PPCUG Treasurer. P.O. Box 3787, Crossville, TN 38557. Our annual dues are 
now payable on July 1st of each year.  Annual dues are $24 per single person / $30 per family starting 7/1/2014 with 
partial years’ dues as follows: 
 

 

 

Join In 
July-Sept 

Annual Dues 
Oct-Dec Jan-Mar Apr-June 

Single: $24 $18 $12 $6 

Families: $30 $22 $15 $7 

  

    

Date: ______________           Amount Paid: $ ____ :.00,  by Cash ___ , or    Check ( #_____________ ) 
                                                

    _____________________________________________ ________________________________  _____________________________________ 

          Last Name         First Name Family Members (if family membership) 

_______________________________________________________________________ 

           Address:  

____________________________          _____ _____________ (_____  )____________________ 

    City                        State     Zip Code Phone Number 

 
E-Mail address:  —————————————————————————————— 
 

 
I have belonged to a Computer Club before. Yes    _____    No _____ _ 
 
l have used PCs since (year):   __________     
 
I have knowledge in the following areas that I would be willing to share with club members:  
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
 
January 2020 
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June 2020 

Sun Mon Tue Wed Thu Fri Sat 

 1 2 3 2:00 P.M. 

PPCUG Board 

Mtg. ???? 

4 5 6 

7 8 9 General 

Mtg.  Presen-
tation. Fol-
lowed By  
Q&A Session 

????? 

10 11 12 13 

14 15 16 17 18 19 20 

21 22 23 24 25 26 27 

28 29 30     


